# Table of Contents

I-Mark™ Help System ........................................................................................................ 1  
FAQ’s & Troubleshooting ................................................................................................. 1  
Using the Help System ..................................................................................................... 4  
  Using the Help System ................................................................................................. 4  
  Help Menu Ribbon ....................................................................................................... 4  
  Using the Help System ................................................................................................. 5  
  Demos ......................................................................................................................... 5  
    F1 Help for a Field ................................................................................................... 5  
Getting Started .................................................................................................................. 7  
  Create a Workspace..................................................................................................... 9  
  Mapping a Controller ................................................................................................. 9  
  Assign Layout to Marking Machine ........................................................................... 9  
Navigating Through the Software .................................................................................. 11  
  Navigate Through Software....................................................................................... 11  
  Software Layout ....................................................................................................... 11  
  Keyboard and Button Navigations ............................................................................. 12  
  Delete ....................................................................................................................... 12  
  Context Menus .......................................................................................................... 13  
Using the Desktop ............................................................................................................ 15  
  Using the Desktop ..................................................................................................... 15  
  What is a Workspace? ............................................................................................... 15  
  Menu Ribbon ............................................................................................................. 15  
Entity Toolbox ................................................................................................................ 15  
  Tool Box ................................................................................................................... 15  
  Graphic Element ...................................................................................................... 16  
  Line Element ............................................................................................................ 16  
  Text Element ............................................................................................................ 16  
  Data Matrix .............................................................................................................. 16  
  Waypoint ................................................................................................................... 16  
  Set Output ................................................................................................................ 16  
  Wait Input ................................................................................................................ 16  
Navigator ......................................................................................................................... 17  
  Marking order .......................................................................................................... 17  
  Properties ................................................................................................................ 17  
  Output Tab ................................................................................................................. 17  
Menu ............................................................................................................................. 19  
  Menu Ribbon ............................................................................................................ 19  
  Main top .................................................................................................................... 19  
    Main top ............................................................................................................... 19  
    Intelli-Mark Start Orb Menu .................................................................................. 19  
    Save All ............................................................................................................... 27  
    Undo .................................................................................................................... 27  
    Redo ..................................................................................................................... 27  
  Home Menu Ribbon ................................................................................................. 27
I-Mark Manual

Home Menu Ribbon.....................................................................................27
Save All .......................................................................................................27
Undo ............................................................................................................27
Redo ............................................................................................................27
Manage Marking Machines..........................................................................27
Disconnect from Network.............................................................................27
Synchronizing ..............................................................................................28

Layout Menu Ribbon .......................................................................................28
Start Marking ...............................................................................................28
Graphic Element..........................................................................................28
Line Element................................................................................................28
Text Element................................................................................................28
Data Matrix ..................................................................................................28
Waypoint......................................................................................................28
Set Output....................................................................................................29
Wait Input.....................................................................................................29
Dwell Time...................................................................................................29
Copy ............................................................................................................30
Cut ...............................................................................................................30
Paste ...........................................................................................................30
Delete ..........................................................................................................30

Marking Ribbon Menu .....................................................................................31
Connect to Marking Machines .....................................................................31
Disconnect from Marking Machine(s) ..........................................................32
Select Active Layout ....................................................................................32
Start Marking ...............................................................................................32

View Menu Ribbon ..........................................................................................32
Display Settings - Zoom Features................................................................34
Display Settings - Grid/Rulers......................................................................34
Tool Box ......................................................................................................35
Properties ....................................................................................................35
Navigator .....................................................................................................35
Marking order...............................................................................................35
Manual Mode...............................................................................................36
Simulation Mode ..........................................................................................36
Output Settings ............................................................................................36

Help Menu Ribbon...........................................................................................36
Using the Help System ................................................................................37
Demos .........................................................................................................37

Marking Machine Menu Ribbon.......................................................................38
Open Marking Machine................................................................................38
Controller Download .....................................................................................38
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Controller Upload</td>
<td>38</td>
</tr>
<tr>
<td>Controller Clock</td>
<td>39</td>
</tr>
<tr>
<td>Assign Layout to Marking Machine</td>
<td>39</td>
</tr>
<tr>
<td>Remove Layout from Controller</td>
<td>40</td>
</tr>
<tr>
<td>Layouts</td>
<td>40</td>
</tr>
<tr>
<td>Counter Configuration</td>
<td>41</td>
</tr>
<tr>
<td>Shifts</td>
<td>42</td>
</tr>
<tr>
<td>Date</td>
<td>42</td>
</tr>
<tr>
<td>I/O Mapping</td>
<td>43</td>
</tr>
<tr>
<td>Enable-disable</td>
<td>43</td>
</tr>
<tr>
<td>Remove Marking Machine</td>
<td>43</td>
</tr>
<tr>
<td>Advanced Topics</td>
<td>45</td>
</tr>
<tr>
<td>Date &amp; Shift Codes</td>
<td>45</td>
</tr>
<tr>
<td>Counter Configuration</td>
<td>45</td>
</tr>
<tr>
<td>E-Stop Suggested Configuration</td>
<td>47</td>
</tr>
<tr>
<td>Waypoint Setup for Custom Tool Path</td>
<td>47</td>
</tr>
<tr>
<td>I/O Setup and Configuration</td>
<td>47</td>
</tr>
<tr>
<td>Multiple Axis Setup</td>
<td>48</td>
</tr>
<tr>
<td>Warning Messages When Saving Files</td>
<td>48</td>
</tr>
<tr>
<td>Error Messages</td>
<td>48</td>
</tr>
<tr>
<td>Error Messages</td>
<td>48</td>
</tr>
<tr>
<td>Error 100</td>
<td>49</td>
</tr>
<tr>
<td>I-Mark Axis Fault Codes</td>
<td>49</td>
</tr>
<tr>
<td>Glossary</td>
<td>51</td>
</tr>
<tr>
<td>Index</td>
<td>55</td>
</tr>
</tbody>
</table>
Welcome

I-Mark™ Help System

FAQ's & Troubleshooting
Access a comprehensive set of questions, answers, and troubleshooting solutions.

Using the Help System
Learn about the features of this Help System

Additional Resources
View additional sources of help.

FAQ's & Troubleshooting
Quick list of all the main help topics. Click on link below to view help information for that category.

For items not listed please use the search feature.

Basic vs Advanced Mode
Creating A Workspace
Creating a Layout
Mapping A controller
Assigning a Layout
Marking a Layout
Date and Shift Codes
Counters
2D Code Sizing
Serial Specification
I/O Mark Start and Complete
E-Stop Suggested Configurations
Waypoint Setup for Custom Tool Path
I/O Setup and Configuration
Multiple Axis Configuration
Warning Messages When Saving Files
Error Messages
Demos
Desktop Map
Layout Window
Machine Window
Orb Menu
Home Ribbon
Marking Ribbon
View Ribbon
Help Ribbon
Layout Ribbon
Marking Machine Ribbon
Entity tool Box
Navigation Window
Marking Window
Marking Order Window
Manual Window
Simulator Window
Output Window
Quick Access Tool Bar
Bottom Status Tool Bar
Create New Layout
Open Layout
Save Layout
Save All
Undo
Redo
Manage Marking Machines
Connect to Marking Machine
Disconnect From Marking Machine
Refresh Network
Download to All
Select Active Machine
Select Active Layout to Mark
Mark Layout
Pen Enable
In the normal course of using the software, questions may arise regarding procedures, system messages, and error conditions. I-Mark Software provides several methods of obtaining answers to your questions.

For information about Columbia Marking Tools products, visit the Columbia Marking Tools Web site at: www.columbiamt.com
Visit the I-Mark Software Online Web site. The I-Mark Online Web site provides a direct link to latest internal research database, downloads, and numerous support services. This service is available only with a current Support Agreement or Client Care Plan and to I-Mark business partners. First year is included free with purchase of I-Mark system. Have Serial Number and Company Name ready to validate access.

Access video demonstrations by selecting Demos on the Help Menu Ribbon.

Technical bulletins and download program updates are available through the I-Mark Software E-News.

Note Program updates are available exclusively through the internet.

For more information about I-Mark Software’s fee-based customer support services, contact Columbia Marking Tools.

Using the Help System

Using the Help System

Access the Help system when you want quick references for software commands, detailed information and entry samples for fields, flowcharts for complex concepts, and FAQ’s and Troubleshooting information. The following topics provide information on the different ways you can access and use the Help system, as well as ways to easily print a grouping of related Help topics.

Using the Help Menu

F1 Help for a Field
Print the Complete Help PDF
(warning quite lengthy)
Adobe Acrobat reader required

Help Menu Ribbon
From the I-Mark Desktop, select Help menu tab across the top of the screen. There are three main items on the help menu:

1. About page which gives information about the software release you are using
2. Access to the Help File
3. Live video Demos. Help Topics

**Using the Help System**

Access the Help system when you want quick references for software commands, detailed information and entry samples for fields, flowcharts for complex concepts, and FAQ's and Troubleshooting information. The following topics provide information on the different ways you can access and use the Help system, as well as ways to easily print a grouping of related Help topics.

**Using the Help Menu**

**F1 Help for a Field**

Print a the Complete Help PDF
(Warning quite lengthy)
Adobe Acrobat reader required

**Demos**

This icon is located in the Help Menu Ribbon. Selecting this command will access a complete list of demonstrations included with the Intelli-Mark software.

How to Create/Open **Workspace** The Intelli-Mark program layout. The windows and navigation may be configured different for different users, applications, or systems.

How to Create/Open **Layout** Marking legend displaying position and style of all the entities to be marked.

Add **Text Data Matrix** to Layout
Change Text Size
Change Text **Font**
Change Entity Alignment
Change Entity Orientation
Make Entity into a Radius

**F1 Help for a Field**

Press F1 at any field in the software to access Help for that field. The field-level Help topic that appears contains information for all fields for the task.
The navigator icon is located in the View Ribbon. This icon will turn show/hide the Navigation Window.
Getting Started

Quick Start Guide

A) **Components**: Each of CMT's systems comes with a marking head, controller, and required cables. For bench-top or turn-key stations these components are pre-assembled.

B) **Installing Software**: Software must be installed on PC running windows (I-Mark is not compatible with Vista 64). For bench-top or turnkey stations an integrated PC is included in the machine and this step is not required.

C) **Connecting the Machine**: Marking **units** require mounting of the head and controller. Turn-key systems require connecting to electrical and possibly an an supply.

D) **Turning on the system**: From the basic bench-top to the mark and read station with accessories.

E) **Getting Started**: The required elements of creating and running a marking program.

Basic versus Advanced mode may be selected on the **Start Page** or from the **Orb Menu**.

Basic mode is streamlined with the basic marking functions and is quicker to set-up Stand-Alone marking machines. Basic mode has only one **workspace**, CMT recommends Advanced Mode for integrators to maximize the I/O and communication capabilities of the I-Mark controllers. Basic Model will connect with all machines on the network. Advanced mode allows for selection of which machines to connect to.

**Start Page** buttons:
Even if the Start Page is closed, a user may still change the mode through the Orb Menu.

Orb Menu Selection:

Selection window is opened to change user mode:
Create a Workspace

Creating a new workspace The Intelli-Mark program layout. The windows and navigation may be configured different for different users, applications, or systems. is only an option in advanced mode.

Only through the workspace may the user limit the machines that the software will try to locate.

In basic mode, all machines on the network are shown in the Navigation window.

The by creating different workspaces the operator may select which machines on the network will be accessed.

Mapping a Controller

Type topic text Data Matrix here.

Assign Layout to Marking Machine

This icon is located in the Marking Machine Ribbon. This ribbon is visible once a marking machine has been selected in the navigation window, and is opened in the Main Work Area.

While a number of marking machines may be opened, the selected machine will be the associated with the name on the Marking Machine Menu Ribbon Tab. In addition, this system will be highlighted and opened in the Main Work Area.

A drop down menu will appear and display all additional layouts from the PC available to be assigned to the machine.

- The layout Marking legend displaying position and style of all the entities to be marked. must reside in the I-Mark data directory located: ...
  Program Files\_Mark_x_x_x (where the small "x"s are the version numbers).
- The layout must have the same marking machine type as the marking machine selected.
If a required layout does not appear check the layouts location on the PC, and the marking machine type assigned to it.

In addition to the Assign Layout icon, I-Mark software also allows for a "drag and drop" method to assign layout to marking machines. This is done by using the navigation window. Click on the layout required and "drag" to the marking machine.

If this symbol continues to appear when you drag layout over marking machine, check to make sure that the layout machine type matches the marking machine type of the desired machine.
Navigating Through the Software

Navigate Through Software

Type topic text Data Matrix here.

Software Layout

Orb Menu: Drop down menu is visible when mouse goes over orb Intellimark symbol in the upper left hand corner of the main window.
Main Top Icons - Icons and commands accessible on the top of the Intelli-Mark screen

Main command ribbons are shown when the name tab is clicked with mouse.
Home Ribbon
Layout Ribbon
Marking Ribbon
View Ribbon
Help Ribbon
Entity Ribbon

Entity Boxes: are opened through the icon ribbons
Entity Toolbox
Navigation
Marking Order
Properties

Use your mouse to hover over different parts of this image to identify them.
Keyboard and Button Navigations

List of Keystroke commands

Delete

is located in the Marking Order Window and

is located to the far right of the Layout Menu Ribbon.

Both icons perform the same command. This command will delete all the currently selected entities in the opened layout Marking legend displaying position and style of all the entities to be marked. These selected entities are outlined by a blue line in the Main Work Area, or highlighted in the Marking Order Window.

In addition, hitting the delete key on the keyboard will perform the same task.
Context Menus

On any Toolbar the following options are displayed when the right button of the mouse is clicked.

Add to Quick Access Toolbar: This adds the icon that the mouse is hovering over to the Quick Access Toolbar with the Save Layout Marking legend displaying position and style of all the entities to be marked, Undo, and Redo buttons.

Show Quick Access Toolbar Below/Above the Ribbon: This puts the Quick Access Toolbar above or below the icon ribbon.

Minimize Ribbon: The ribbon will not display until the top command is clicked, and will disappear when the mouse is clicked outside of the ribbon area.
Using the Desktop

What is a Workspace?

A Workspace is the Intelli-Mark program layout. The windows and navigation may be configured different for different users, applications, or systems. It is a collection of Layouts, files and settings which create associations to the controllers they're assigned to. A good example of this would be to consider a large manufacturing plant. Within this plant are different groups of machining cells dedicated to one type of part. Within these cells would be one or more I-Mark Controllers including their marking Layouts, Graphics, Fonts and any of the specific Settings of these controllers. The Workspace provides us with a way to organize these items into a group to be better managed and monitored by a computer or person.

Assume that you are an engineer who is in charge of one of these machining cells. Although there are multiple cells throughout the plant each with their own group of I-Mark machines, you wouldn't necessarily want to monitor or modify one of these other groups. The Workspace file would allow you to map the controllers pertaining to your cell to your Workspace. Once you open the I-Mark software and open up this Workspace file, you would be shown only the controllers belonging to it and their contents. This makes for a much cleaner organization method and makes managing multiple controllers a breeze.

Menu Ribbon

Entity Toolbox

Tool Box
Waypoint

The **waypoint** icon is located in the **Layout Ribbon**. This Ribbon menu is only available if a layout Marking legend displaying position and style of all the entities to be marked is active in the center work area.

Clicking on this icon will create a new waypoint in the open layout. The new waypoint will be created in the x-y **position** of the last entity in the layout and after the last entity in the **Marking Order Window**.

The **properties** of this waypoint are shown the **Properties Window** when the entity is selected.

- the use of a series of waypoints is a nice way to assure that critical path points may be entered into the marking legend. Most common use of this feature is for part relief and other obstructions.

Set Output

Type topic **text Data Matrix** here.

Wait Input
The Wait for Input icon is located in two places in the Intelli-Mark software, one is on the **Layout Ribbon** and one is in the **Entity Toolbox**.

The "**Wait Input**" entity is a **non-printing Entities within the layout that do not produce a mark. These include: Waypoints, Outputs, Inputs, and Dwell Time.** object, and will pause until the required I/O operation is completed.

Once the Wait Input entity is selected on the opened **layout** the configuration associated with it may be changed. These variables may be changed in the **Properties** Window.

---

**Navigator**

The navigator icon.

This icon is located in the **View Ribbon**. This icon will turn show/hide the **Navigation** Window.

---

**Marking order**

Type topic **text Data Matrix** here.

---

**Properties**

Type topic **text Data Matrix** here.

---

**Output Tab**

Type topic **text Data Matrix** here.
Menu

Menu Ribbon

Type topic text Data Matrix here.

Main top

Main top

Type topic text Data Matrix here.

Intelli-Mark Start Orb Menu

I-Mark Start Orb Menu

A mouse click on the start Orb Intellimark symbol in the upper left hand corner of the main window will show the following icons.

- New Workspace
- Open Workspace
- Save Workspace
- Save Workspace As
- Create New Layout
- Open Layout
- Import Layout
- Save Layout
- Save Layout As
- Change Access

New Workspace
A workspace is a definition of the machine parameters and the Global I-Mark Environment. Examples of some parameters are:

- What Machines are available to mark with (mapped)
- Global Machine Settings
- Global Counter Settings
- Global I/O configuration

By creating a new workspace the system will search for any machines that are connected to your computer or network and allow you to connect to them. Once connected you can begin to edit their properties. You can create new workspace in two different ways:

1.) **Select New Workspace from the ORB menu**
2.) Select Advanced or Basic mode from the Start Page
Open Workspace

Opens and existing workspace and all of the configured settings saved in that Workspace. You can open a work space by selecting Open Workspace from the ORB Menu.
Save Workspace

Save Workspace allows you to save any changes that you have made to an existing workspace. You can Save your workspace by selecting Save Workspace from the ORB menu.
Save Workspace As

Save Workspace As allows you to save a given workspace to a different Name. You can save Workspace As by selecting it from the ORB menu.
Create New Layout

This icon is located in two places; the Orb Menu and the Home Menu Ribbon. This command will create a blank layout in the current workspace.
This file is not automatically created nor saved. The filename on the tab in the Main Work Area will be followed by an asterisk if the file has not been saved in its current state.

When the file is saved the file is located in the data directory under the Intelli-Mark program files. The extension name is .ctml.

Open Layout
Type topic text Data Matrix here.

Save Layout
Type topic text Data Matrix here.

Save Layout As
Type topic text Data Matrix here.

Change User Mode
Change User Mode icon is located as the bottom menu option in the drop down Orb Menu.

I-Mark software allows for different access levels based on user knowledge and responsibility.

The standard software has two modes Basic and Advanced.

Custom software settings may restrict some of the advanced software settings. The software may be restricted for single machine use, or may be limited in I/O protocols and 2D functionality.

In addition, advanced software applications may have different access levels to ensure that marking legends and settings are not changed inadvertently. And may even be customized to allows access to certain machines on the network and not others, depending on responsibility.

Options
Type topic text Data Matrix here.
Exit
Type topic *text Data Matrix* here.

Save All
Type topic *text Data Matrix* here.

Undo
Type topic *text Data Matrix* here.

Redo
Type topic *text Data Matrix* here.

**Home Menu Ribbon**

Home Menu Ribbon
Type topic *text Data Matrix* here.

Save All
Type topic *text Data Matrix* here.

Undo
Type topic *text Data Matrix* here.

Redo
Type topic *text Data Matrix* here.

**Manage Marking Machines**

Type topic *text Data Matrix* here.

**Disconnect from Network**

If you wish to disconnect your computer from the network, the best way to accomplish this is to first Save your *workspace The Intelli-Mark program layout*. *The windows and navigation may be configured different for different users, applications, or systems.* and then perform a Download to All. This will ensure
that any changes made during your session connected to the network will be saved both within the workspace and on the controller(s) themselves. Finally press the Disconnect from Marking Machine(s) button found on the Home tab. Once you have done these steps in succession, you can either close the I-Mark application or unplug your computer from the network on which you were working.

Synchronizing

Type topic text Data Matrix here.

Layout Menu Ribbon

Layout Menu Ribbon

Type topic text Data Matrix here.

Start Marking

Type topic text Data Matrix here.

Graphic Element

Type topic text Data Matrix here.

Line Element

Type topic text Data Matrix here.

Text Element

Type topic text Data Matrix here.

Data Matrix

Type topic text Data Matrix here.

Waypoint

The waypoint icon is located in the Layout Ribbon. This Ribbon menu is only available if a layout Marking legend displaying position and style of all the entities to be marked is active in the center work area.
Clicking on this icon will create a new waypoint in the open layout. The new waypoint will be created in the x-y position of the last entity in the layout and after the last entity in the Marking Order Window.

The properties of this waypoint are shown in the Properties Window when the entity is selected.

The use of a series of waypoints is a nice way to assure that critical path points may be entered in to the marking legend. Most common use of this feature is for part relief and other obstructions.

Set Output

Type topic text Data Matrix here.

Wait Input

The Wait for Input icon is located in two places in the Intelli-Mark software, one is on the Layout Ribbon and one is in the Entity Toolbox.

The "Wait Input " entity is a non-printing Entities within the layout that do not produce a mark. These include: Waypoints, Outputs, Inputs, and Dwell Time. object, and will pause until the required I/O operation is completed.

Once the Wait Input entity is selected on the opened layout the configuration associated with it may be changed. These variables may be changed in the Properties Window

Dwell Time

The dwell time icon is located in two places in the Intelli-Mark software, one is on the Layout Ribbon and one is in the Entity Toolbox.
The "Dwell Time" entity is a non-printing object, and will input a pause into the marking operation. This is used as parts are moved, measurement/camera operations occur, or fixture and guarding motions complete.

Once the Dwell Time entity is selected on the opened layout the time value associated with it may be changed. This value is in milliseconds.

1 equals 1ms
1000 equals 1 second

**Copy**

The icon is located on the far left side of the Layout Menu Ribbon. The Layout Menu Ribbon is only available if a layout is open in the Main Work Area. When selected this command copies all the currently selected entities to the clipboard.

After using the copy command, using the paste command will create a duplicate set of entities. Multiple sets of entities may be created by continued use of the paste command.

**Cut**

The icon is located on the far left side of the Layout Menu Ribbon. The Layout Menu Ribbon is only available if a layout is open in the Main Work Area. When selected this command cuts all the currently selected entities and copies them to the clipboard.

After using the cut command, using the paste command will create a new set of entities. Multiple sets of entities may be created by continued use of the paste command.

**Paste**

This icon is located on the far right of the Layout Menu Ribbon. Using this command will place into the currently opened layout the entities that have been copied into the clipboard.

**Delete**
is located in the **Marking Order Window** and is located to the far right of the **Layout Menu Ribbon**.

Both icons perform the same command. This command will delete all the currently selected entities in the opened *layout Marking legend displaying position and style of all the entities to be marked*. These selected entities are outlined by a blue *line* in the Main Work Area, or highlighted in the **Marking Order** Window.

In addition, hitting the delete key on the keyboard will perform the same task.

**Marking Ribbon Menu**

**Marking Ribbon Menu**

![Diagram of Menu](image)

- **Connect to Marking Machines**
- **Disconnect from Marking Machines**
- **Select Layout**
- **Mark Layout**
This icon is located in the **Marking Menu Ribbon**. When selected it will list the Intelli-Mark controllers/marking systems that are available on the network.

If no systems are available, check the following issues:
1. Is the computer that I-Mark is running on connected to the network?
2. Are the Marking Systems connected to the Network?
3. Are the Marking Systems on?
4. Have the Marking Systems been properly configured/mapped?

**Disconnect from Marking Machine(s)**

This function can be found on the Home Ribbon Menu. When clicked, I-Mark will release its connection with the Mapped Controllers within your **Workspace**.

**Select Active Layout**

This icon is located in the Marking Ribbon Menu. Select a *layout Marking legend displaying position and style of all the entities to be marked.* from the list of layout on the **marking machine**. The highlighted layout will be run when the marking machine is next cycled.

This command is followed by the Mark Layout icon or **Start Marking**

Type topic **text Data Matrix** here.

**View Menu Ribbon**

The View Menu Ribbon is shown when the view tab is selected. All of the icons on this menu effect the look of the **workspace**.

First Group on left hand side of Ribbon controls the **Zoom**
Second Group in the middle of the ribbon controls the Look:

*Grid Lines*: Check box for on. Internal grid lines go through the *layout Marking legend displaying position and style of all the entities to be marked*. area. Grid lines are shown every inch, or 5 millimeters.

*Rulers*: Check box for on. Rulers run along the top and left of the layout screen. They display inches or Millimeters depending on the *units*.

Axis Labels: Check Box for on. Specifies X,Y axis and *motion* type (linear, rotational), and Units.

Home *Position*: Check Box for on. Home position is labeled with two intersecting green lines with arrows.

Units: English or Metric. Select system through drop down menu. If In is shown the units are in Inches. If MM is shown the units are in millimeters.

The Third group on the right hand side of the ribbon controls seven other windows

*Toolbox*

*Properties*

*Navigator*
Display Settings - Zoom Features

The **Zoom** features are controlled through four icons on the far left of the View Menu Ribbon.

- The **in** icon will zoom in to a smaller area of the *layout* file on the screen.
- The **Actual** icon will reflect the actual size of the mark. If used with *pen* options it will help determine how close lines and character will be on the final product.
- The **out** icon will zoom out to show more of the layout file on the screen.
- The **Fit** icon will automatically display the entire marking field in the Main Work Area.

Display Settings - Grid/Rulers
<table>
<thead>
<tr>
<th>Marking</th>
<th>View</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️ Grid Lines</td>
<td>✔️ Home Position</td>
<td>mm</td>
</tr>
<tr>
<td>✔️ Rulers</td>
<td></td>
<td></td>
</tr>
<tr>
<td>✔️ Axis Labels</td>
<td>Units</td>
<td></td>
</tr>
</tbody>
</table>

### Center portion of the View Menu Ribbon

**Grid Lines**: Check box for on. Internal grid lines go through the *layout* area. Grid lines are shown every inch, or 5 millimeters.

**Rulers**: Check box for on. Rulers run along the top and left of the layout screen. They display inches or Millimeters depending on the *units*.

Axis Labels: Check Box for on. Specifies X,Y axis and *motion* type (linear, rotational), and Units.

Home *Position*: Check Box for on. Home position is labeled with two intersecting green lines with arrows.

Units: English or Metric. Select system through drop down menu. If In is shown the units are in Inches. If MM is shown the units are in millimeters.

### Tool Box

Type topic *text Data Matrix* here.

### Properties

Type topic *text Data Matrix* here.

### Navigator

![The navigator icon.](image)

This icon is located in the View Ribbon. This icon will turn show/hide the Navigation Window.

### Marking order
Manual Mode

Type topic *Data Matrix* here.

Simulation Mode

Type topic *Data Matrix* here.

Output Settings

Type topic *Data Matrix* here.

Help Menu Ribbon

From the I-Mark Desktop, select Help menu tab across the top of the screen. There are three main items on the help menu:

1. **About** page which gives information about the software release you are using
2. Access to the **Help File**
3. Live video **Demos**. Help Topics

This icon is located in the Help Menu Ribbon, and opens a window containing the information about the software.

Included on the page is the address and contact information for the servicing center:

I-Mark
27430 Luckino Dr
Chesterfield MI 48047
There is also a link to the website, www.marking-machines.net. This site includes all the latest upgrades and FAQ's. The I-Mark Online Web site provides a direct link to latest internal research database, downloads, and numerous support services. This service is available only with a current Support Agreement or Client Care Plan and to I-Mark business partners. First year is included free with purchase of I-Mark system.

In addition, the version and release of the software is also noted. Please provide this information with all requests.

**Using the Help System**

Access the Help system when you want quick references for software commands, detailed information and entry samples for fields, flowcharts for complex concepts, and FAQ's and Troubleshooting information. The following topics provide information on the different ways you can access and use the Help system, as well as ways to easily print a grouping of related Help topics.

**Using the Help Menu**

- F1 Help for a Field
- Print a complete Help PDF
  (warning quite lengthy)
- Adobe Acrobat reader required

**Demos**

- this icon is located in the Help Menu Ribbon. Selecting this command will access a complete list of demonstrations included with the Intelli-Mark software.

How to Create/Open **Workspace** The Intelli-Mark program layout. The windows and navigation may be configured different for different users, applications, or systems.

How to Create/Open **Layout** Marking legend displaying position and style of all the entities to be marked.

Add **Text Data Matrix** to Layout

Change Text Size

Change Text **Font**
Marking Machine Menu Ribbon

Open Marking Machine

Type topic text Data Matrix here.

Controller Download

This icon is located in the Marking Machine Menu Ribbon. This ribbon is only available when a marking machine is opened in the Main Work Area. When selected this command will update all the layouts assigned to the controller with the most recent saved layouts on the PC.

While a number of marking machines may be opened, the selected machine will be the associated with the name on the Marking Machine Menu Ribbon Tab. In addition, this system will be highlighted and opened in the Main Work Area.

Files on the controller may also be updated by dragging and dropping in the Navigation Window.

In addition, a layout Marking legend displaying position and style of all the entities to be marked. file on the controller may be edited directly in the controller. This is accomplished by double clicking on the layout file associated with the marking machine in the Navigation Window.

Warning messages will occur about the revision of a layout file, if the Marking System is selected to run and contains an earlier version of a layout file of an assigned layout file than the file resident on the marking System.

Controller Upload

This icon is located in the Marking Machine Menu Ribbon. This ribbon is only available when a marking machine is opened in the Main Work Area. When selected this command will upload all the layouts that reside on the controller to the PC.
While a number of marking machines may be opened, the selected machine will be associated with the name on the Marking Machine Menu Ribbon Tab. In addition, this system will be highlighted and opened in the Main Work Area.

Files on the controller may also be updated by dragging and dropping in the Navigation Window.

In addition, a layout Marking legend displaying position and style of all the entities to be marked file on the controller may be edited directly in the controller. This is accomplished by double clicking on the layout file associated with the marking machine in the Navigation Window.

Warning messages will occur about the revision of a layout file, if the Marking System is selected to run and contains an earlier version of a layout file of an assigned layout file than the file resident on the marking System.

Controller Clock

This icon is located on the Marking Machine Menu Ribbon. This ribbon is visible once a marking machine has been selected in the navigation window, and is opened in the Main Work Area. When selected this command will synchronize the clock on the selected marking machine to match the PC clock.

While a number of marking machines may be opened, the selected machine will be associated with the name on the Marking Machine Menu Ribbon Tab. In addition, this system will be highlighted and opened in the Main Work Area.

Assign Layout to Marking Machine

This icon is located in the Marking Machine Ribbon. This ribbon is visible once a marking machine has been selected in the navigation window, and is opened in the Main Work Area.

While a number of marking machines may be opened, the selected machine will be associated with the name on the Marking Machine Menu Ribbon Tab. In addition, this system will be highlighted and opened in the Main Work Area.

A drop down menu will appear and display all additional layouts from the PC available to be assigned to the machine.
The layout Marking legend displaying position and style of all the entities to be marked must reside in the I-Mark data directory located:

...Program Files\I_Mark_x_x_x (where the small "x"s are the version numbers).

The layout must have the same marking machine type as the marking machine selected.

If a required layout does not appear check the layouts location on the PC, and the marking machine type assigned to it.

In addition to the Assign Layout icon, I-Mark software also allows for a "drag and drop" method to assign layout to marking machines. This is done by using the navigation window. Click on the layout required and "drag" to the marking machine.

If this symbol continues to appear when you drag layout over marking machine, check to make sure that the layout machine type matches the marking machine type of the desired machine.

Remove Layout from Controller

Type topic text Data Matrix here.

Layouts

Layouts are the files associated with the marking programs. They contain both marking and non-marking entities. These files may be managed through the Intelli-Mark software via a PC. They may be resident on either or both the PC and the Marking Machines.

These files are not automatically created nor saved. The filename on the Main Work Area tab will be followed by an asterisk if the file has not been saved in its current state.
When the file is saved the file is located in the data directory under the Intelli-Mark program files. The extension name is .ctml

Counter Configuration

This counter configuration icon is located on the Marking Machine Menu Ribbon. This ribbon is only available when a marking machine is opened and selected in the Main Work Area.

While a number of marking machines may be opened, the selected machine will be the associated with the name on the Marking Machine Menu Ribbon Tab. In addition, this system will be highlighted and opened in the Main Work Area.

When selected the following configuration window appears.

### Configure Counters

<table>
<thead>
<tr>
<th>Counter</th>
<th>Increment</th>
<th>Final</th>
<th>Reset</th>
<th>Reset Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Counter 1</td>
<td>3</td>
<td>100</td>
<td>6</td>
<td>Daily</td>
</tr>
<tr>
<td>Counter 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Counter 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Counter 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Counter 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Counter 6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Counter 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Counter List: List of counters in the marking machine.

Increment: Value the counter changes each time the machine is cycled.

Final: the value at which the counter will stop.

Reset: The number which the counter will reset to
Reset Condition: If set to NONE, the counter will not reset. If set to FINAL, the counter will reset when it reaches the final value. If set to DAILY, the counter will reset at the end of each day. If set to END OF SHIFT, the counter will reset at the end of each shift. This command is paired with the Shift configuration.

When INPUT is select as a reset condition additional fields will display.

Input: Requires a I/O number form 1 through 7, and relates to the I/O position in the Controller.

Input Level: This option is specified as either low or high.

Additional information about the counters in the marking machine is located on the Status & Control Tab of the marking machine in the Main Work Area.

Currently the standard counter does NOT have the functionality for counting down, having negative values, or numeric type other than integers.

Shifts

Type topic text Data Matrix here.

Date

Type topic text Data Matrix here.
I/O Mapping

If you are unable to find the answer to your I-Mark questions in the standard product documentation or online, phone support is available at the following locations:

---

Enable-disable

Type topic **text Data Matrix** here.

Remove Marking Machine

Type topic **text Data Matrix** here.
Advanced Topics

Date & Shift codes
Counters
Serial Specifications
I/O Mark Start and Complete
E-Stop Suggested Configuration
Waypoint Setup for Custom Tool Path
I/O Setup and Configuration
Multiple Axis Setup
Warning Messages When Saving Files
Error Messages

Date & Shift Codes

There are three elements to completely program the date and shift codes.

1) **Is to program the date and shift codes in a dynamic text entity.** This involves creating a text entity and properly denoting the codes for the date/time features required.

2) **Is to configure the shifts in the marking machine.** This involves selecting a marking machine and creating an array of shifts.

3) **Is to configure the date and time for the marking machines.** This involves selecting a marking machine and editing the Months, Days, AM/PM and/or Time Zone information.

Counter Configuration

This counter configuration icon is located on the Marking Machine Menu Ribbon. This ribbon is only available when a *marking machine* is opened and selected in the Main Work Area.

While a number of marking machines may be opened, the selected machine will be the associated with the name on the Marking Machine Menu Ribbon Tab. In addition, this system will be highlighted and opened in the Main Work Area.

When selected the following configuration widow appears.
Counter List: List of counters in the marking machine.

Increment: Value the counter changes each time the machine is cycled.

Final: the value at which the counter will stop.

Reset: The number which the counter will reset to

Reset Condition: If set to NONE, the counter will not reset. If set to FINAL, the counter will reset when it reaches the final value. If set to DAILY, the counter will reset at the end of each day. If set to END OF SHIFT, the counter will reset at the end of each shift. This command is paired with the Shift configuration.

When INPUT is select as a reset condition additional fields will display.

Input: Requires a I/O number form 1 through 7, and relates to the I/O position in the Controller.

Input Level: This option is specified as either low or high.
Advanced Topics

Additional information about the counters in the marking machine is located on the Status & Control Tab of the marking machine in the Main Work Area.

Currently the standard counter does NOT have the functionality for counting down, having negative values, or numeric type other than integers.

E-Stop Suggested Configuration

Type topic text Data Matrix here.

Waypoint Setup for Custom Tool Path

Type topic text Data Matrix here.

I/O Setup and Configuration

The following are the suggested integration and timing sequences for the 1) Standard Operation, 2) Operation with Fault/E-Stop Recovery, and 3) Operation with Serial Data String

1) Standard Operation
2) Operation with Fault/E-Stop Recovery

<table>
<thead>
<tr>
<th>Input / Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output pin-3</td>
<td>Ready</td>
</tr>
<tr>
<td>Input pin-2</td>
<td>Start</td>
</tr>
<tr>
<td>Output pin-4</td>
<td>Marking</td>
</tr>
<tr>
<td>Output pin-6</td>
<td>Faulted</td>
</tr>
<tr>
<td>Input pin-3</td>
<td>Reset</td>
</tr>
<tr>
<td>Output pin-3</td>
<td>Ready</td>
</tr>
<tr>
<td>Input pin-2</td>
<td>Start</td>
</tr>
<tr>
<td>Output pin-4</td>
<td>Marking</td>
</tr>
<tr>
<td>Output pin-5</td>
<td>Complete</td>
</tr>
<tr>
<td>Output pin-3</td>
<td>Ready</td>
</tr>
</tbody>
</table>

3) Operation with Serial Data String

<table>
<thead>
<tr>
<th>Input / Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output pin-3</td>
<td>Ready</td>
</tr>
<tr>
<td>Serial Port</td>
<td>&quot;send ASCII data&quot;</td>
</tr>
<tr>
<td>Input pin-2</td>
<td>Start</td>
</tr>
<tr>
<td>Output pin-4</td>
<td>Marking</td>
</tr>
<tr>
<td>Output pin-5</td>
<td>Complete</td>
</tr>
<tr>
<td>Output pin-3</td>
<td>Ready</td>
</tr>
</tbody>
</table>

Multiple Axis Setup

Type topic text Data Matrix here.

Warning Messages When Saving Files

Type topic text Data Matrix here.

Error Messages
Advanced Topics

Type topic *text Data Matrix* here.

**Error 100**

Type topic *text Data Matrix* here.

**I-Mark Axis Fault Codes**

Type topic *text Data Matrix* here.
Glossary

B
Basic Mode:

D
Data:
Dimensions:
Dwell:
Dwell Timer:
Dynamic: Text or data Matrix marking entities. These entities may change from mark to mark.

E
Entity Toolbox: Window that contain all the entities that may be put into a marking layout: Static, Dynamic, and Non-Printing

F
Fit:
Font:

G
Graphic:
Grid Lines:

H
Home: Home position is defined as the maximum X and the Zero Y. This is the position that the marker is defaulted to start each cycle from.

L
Layout: Marking legend displaying position and style of all the entities to be marked.
Line:
Manual:
Marking Machine:
Marking Order:
Motion:

Navigation:
Non-Printing: Entities within the layout that do not produce a mark. These include: Waypoints, Outputs, Inputs, and Dwell Time.

Orb: Intellimark symbol in the upper left hand corner of the main window.

Pen:
Position:
Properties:

Rulers:

Set Output:
Simulation:
Static: Entities that do not change. These include lines, and graphics.

Text: Data Matrix

Units:

Wait Input:
**Waypoint:**

**Workspace:** The Intelli-Mark program layout. The windows and navigation may be configured different for different users, applications, or systems.

**Zoom:**
Index

1
1ms ............................................... 29
2
2D ................................... 1, 5, 26, 37
2D Code Sizing ......................... 1
A
About .. 1, 3, 4, 36, 37, 38, 39, 41, 45
About Columbia Marking Tools ...... 3
Above ............................................ 13
   Ribbon .................................. 13
Accept ..................................... 13, 31
Access File Layouts .................... 3
Activity ............................................ 1
Actual icon .................................... 34
Adding ..................................... 13, 27
   Controllers ................................ 27
   Quick Access Toolbar .................... 13
Additional Resources ................ 1, 3
Adobe Acrobat .............................. 4, 5, 37
Advanced ........................ 7, 9, 26, 45
Advanced Mode ......................... 7
Advanced Topics .......................... 45
Assign ............. 1, 5, 9, 15, 37, 38, 39
Axis Labels ...................... 32, 35
B
Basic ............................................. 1, 7, 9, 26
Basic Model ................................. 7
Basic Vs Advanced ..................... 1, 7
Bottom Status Tool Bar ............. 1
Box ........................................... 1, 11, 15, 32, 35
Button Navigations ..................... 12
C
Cancel ........................................ 13, 31
Change Access .......................... 26
Change User Mode ..................... 7, 26
Clock ........................................... 1, 39
Configuration .... 1, 16, 29, 41, 45, 47
Configure .................. 1, 5, 15, 32, 37
Control .................. 32, 34, 41, 45
Control Tab .................. 41, 45
marking ................................ 41, 45
Controller Clock .................. 1, 39
Controller Download ........... 1, 38
Controller Upload ............. 1, 39
Controllers .. 1, 5, 7, 9, 15, 27, 28, 32,
   37, 38, 39, 40, 41, 45
   Adding .................................. 27
Controllers belonging ............. 15
Controllers including ............. 15
Copy ........................................... 1, 30
Counter Configuration ............ 41, 45
Counter List ......................... 41, 45
Counters .................................. 1, 41, 45
Create .. 1, 5, 7, 9, 15, 16, 25, 28, 30,
   37, 40
Create New Layout ............... 1, 25
Custom Tool Path ................... 1, 47
   Waypoint Setup .................. 47
Cut ............................................. 1, 30
D
DAILY ..................................... 41, 45
set ........................................... 41, 45
Data Matrix ........................ 1, 4, 5, 7, 9, 11, 12, 15,
   16, 17, 19, 22, 23, 24, 26, 27, 28,
   29, 32, 35, 36, 37, 38, 40, 43, 44,
   45, 47, 48, 49
Date ............................................ 1, 5, 37, 43, 45
Delete ........................................ 1
Demonstration .................. 1, 3, 4, 5, 37
Demonstration Icon .......................... 5, 37
Demos ........................................ 1, 3, 4, 5, 36, 37
   selecting .................................... 3
Desktop .............................. 1, 4, 11, 15, 36
   Using .................................... 15
Desktop Map ............................. 1, 11
Diagnostics .............................. 1
Disconnect .................................. 1, 28, 31, 32
Disconnect From .................... 1, 28, 31, 32
Display Settings ..................... 1, 34, 35
Download .............................. 1, 3, 28, 37
Dwell Time .......................... 1, 16, 29
Dynamic .................................... 1
Dynamic Elements .......................... 1
Manage Marking Machines........ 1, 27
Manual Mode ....................... 1, 36
Manual Window ..................... 1
Mapped Controllers.................. 32
Mark... 1, 3, 4, 5, 7, 9, 11, 13, 15, 16,
17, 25, 26, 27, 28, 29, 31, 32, 34,
35, 36, 37, 38, 39, 40, 41, 44, 45
Control Tab ................. 41, 45
Mark Start ......................... 1
Marking .............................. 38
Marking legend ... 1, 5, 9, 13, 15, 16,
26, 28, 31, 32, 37, 38, 39
Marking legend displaying position 1,
5, 9, 13, 15, 16, 28, 31, 32, 37, 38,
39
Marking Machine.. 1, 7, 9, 15, 28, 31,
32, 37, 38, 39, 40, 41, 45
Marking Machine Ribbon ...... 1, 9, 39
Marking Ribbon............. 1, 11, 31, 32
Marking Ribbon Menu............ 31, 32
Marking Systems .... 3, 32, 37, 38, 39
Marking Systems connected...... 32
Network ............................ 32
Marking Window .................... 1
Match .................................. 9, 39
PC .................................... 39
Menu effect .......................... 32
look.................................. 32
Menu Ribbon ... 9, 13, 15, 19, 28, 30,
31, 32, 38, 39, 40, 41, 45
Menu Ribbon Tab .. 9, 38, 39, 41, 45
Menus 4, 5, 9, 11, 13, 15, 16, 19, 25,
26, 27, 28, 30, 31, 32, 35, 37, 38,
39, 41, 45
Messages When Saving Files... 1, 48
Warning.............................. 48
Metric ............................... 32, 35
Millimeters......................... 32, 35
Millimeters depending........... 32, 35
units............................. 32, 35
Minimize Ribbon .................. 13
MM.................................. 32, 35
Multiple Axis Configuration .... 1
Multiple Axis Setup ............... 48

Navigate Through Software........ 11
Navigation Window... 1, 9, 17, 35, 38,
39
man.................................. 17, 35
Navigator .....................1, 17, 32, 35
Network ...................1, 7, 9, 26, 28, 32
Marking Systems connected..... 32
New Workspace ................. 9, 19
News .................. 3, 9, 16, 19, 28, 30
NONE.................................. 41, 45
set................................. 41, 45
Non-Printing Elements .......... 1

O 1, 5, 7, 16, 26, 29, 37, 41, 45
Open Layout. 1, 5, 13, 16, 26, 28, 29,
30, 31, 37
Open Marking Machine ............ 38
Open Workspace .................... 5, 22, 37
Options.......... 9, 13, 26, 27, 34, 41, 45
Orb ................... 1, 7, 11, 15, 19, 25, 26
Orb Menu ...... 1, 7, 11, 15, 19, 25, 26
Orb Menu Selection ............... 7
Order1, 11, 13, 16, 17, 28, 31, 32, 36
Marking ............................ 17, 36
Order Window ...... 1, 13, 16, 28, 31
Output Settings .................. 1, 36
Output Tab ..................... 1, 17
Output Window .................... 1
Outputs............... 1, 16, 17, 29, 32, 36

P Paste............................... 1, 30
PC ................................. 7, 9, 32, 38, 39, 40
 match.......................... 39
PC running .......................... 7
PDF's .............................. 4, 5, 37
Pen.................................. 1, 34
Pen Disabled....................... 1
Pen Enabled....................... 1
Position .... 1, 5, 9, 13, 15, 16, 28, 31,
32, 37, 38, 39, 41, 45
Press F1 ......................... 5
Program . 1, 3, 5, 7, 9, 15, 25, 37, 39,
40
Program Files ............ 9, 25, 39, 40
Program Information ....... 3
30, 31, 32, 34, 35, 36, 37, 38, 39, 40, 41, 43, 44, 45, 47, 48, 49
Troubleshooting ......... 1, 4, 5, 37
U
Undo ................................. 1, 13, 27
Units............................... 1, 7, 32, 35
Millimeters depending .... 32, 35
Unmap From Workspace .... 1
Upload .............................. 1, 39
Upper left hand corner ..... 11, 19
main window...................... 11
Using. 1, 3, 4, 5, 9, 15, 30, 36, 37, 39
Desktop ............................. 15
Help System ...................... 4, 5, 37
V
View Menu Ribbon......... 32, 34, 35
View Ribbon................ 1, 11, 17, 35
View Settings .................. 1
Vista 64............................. 7
W
Wait ................................. 1, 16, 29
Input icon ...................... 16, 29
Wait Input ....................... 1, 16, 29
Wait Time ...................... 1, 29
Warning ......................... 48
Messages When Saving Files ... 48
Waypoint ..................... 1, 16, 28, 29, 47
Waypoint Setup ............. 1, 47
Custom Tool Path ........... 47
Website ......................... 37
link ............................... 37
Will input ...................... 29
Will pause ...................... 16, 29
Workspace 1, 7, 9, 15, 19, 22, 23, 24, 25, 28, 32
Z
Zoom ............................. 1, 32, 34
Zoom Features ............... 1, 34
Zoom In ......................... 32, 34
Zoom Out ....................... 32, 34